Technology Institute for Music Educators

Digital Audio
(Student Manual)

by Floyd Richmond, Tom Rudolph,
Vince Leonard, Lee Bilotta,
Jeff Wiles, Rocky Reuter

2005 Revisions by
Floyd Richmond, Vince Leonard, Lee Bilotta, Tom Rudolph

2006 Updates by Floyd Richmond

Edited by Floyd Richmond

Copyright © 2004-2006 Technology Institute for Music Educators
http://www.ti-me.org
# Table of Contents

## Student Workbook

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Syllabus</td>
<td>1</td>
</tr>
<tr>
<td>Description</td>
<td>1</td>
</tr>
<tr>
<td>Additional Information</td>
<td>1</td>
</tr>
<tr>
<td>Hardware Requirements</td>
<td>2</td>
</tr>
<tr>
<td>Software Requirements</td>
<td>2</td>
</tr>
<tr>
<td>Introduction</td>
<td>3</td>
</tr>
<tr>
<td>Prerequisites</td>
<td>3</td>
</tr>
<tr>
<td>Objectives</td>
<td>3</td>
</tr>
<tr>
<td>Declarative Knowledge</td>
<td>3</td>
</tr>
<tr>
<td>Procedural Knowledge</td>
<td>3</td>
</tr>
<tr>
<td>Summary of Assessment</td>
<td>4</td>
</tr>
<tr>
<td>Course Topics</td>
<td>5</td>
</tr>
<tr>
<td>Topic #1 - The first recording</td>
<td>6</td>
</tr>
<tr>
<td>Topic #2 - The first CD</td>
<td>10</td>
</tr>
<tr>
<td>Topic #3 - Looping Software</td>
<td>12</td>
</tr>
<tr>
<td>Topic #4 - Record piano accompaniment and a solo (stereo record) and burn to CD.</td>
<td>13</td>
</tr>
<tr>
<td>Topic #5 - Record a duet using two track (stereo) recording software and burn to CD</td>
<td>17</td>
</tr>
<tr>
<td>Topic #6 - Record a quartet using multi-track recording software and burn to CD</td>
<td>18</td>
</tr>
<tr>
<td>Topic #7 - Setup activity and discussion</td>
<td>19</td>
</tr>
<tr>
<td>Topic #8 - Acoustic considerations</td>
<td>24</td>
</tr>
<tr>
<td>Topic #9 - Record class/small chamber ensemble</td>
<td>28</td>
</tr>
<tr>
<td>Topic #10 - Record class/small vocal ensemble</td>
<td>30</td>
</tr>
<tr>
<td>Topic #11 - Editing project 1</td>
<td>31</td>
</tr>
<tr>
<td>Topic #12 - Editing project 2</td>
<td>31</td>
</tr>
<tr>
<td>Topic #13 - Editing project 3</td>
<td>31</td>
</tr>
<tr>
<td>Topic #14 - Mastering</td>
<td>35</td>
</tr>
<tr>
<td>Topic #15 - Converting recordings in one format to another</td>
<td>36</td>
</tr>
<tr>
<td>Topic #16 - Final project</td>
<td>38</td>
</tr>
<tr>
<td>Topic #17 - Digital Audio and Copyright</td>
<td>39</td>
</tr>
<tr>
<td>Topic #18 - Digital Audio and the MENC National Standards</td>
<td>41</td>
</tr>
<tr>
<td>Appendices</td>
<td>19</td>
</tr>
<tr>
<td>Appendix 1: Software Recommendations</td>
<td>43</td>
</tr>
<tr>
<td>Appendix 2: Digital Audio Article</td>
<td>44</td>
</tr>
<tr>
<td>Jeff Wiles Article</td>
<td>44</td>
</tr>
<tr>
<td>Appendix 3: Tutorials</td>
<td>48</td>
</tr>
<tr>
<td>Floyd Richmond Logic Tutorial</td>
<td>49</td>
</tr>
<tr>
<td>Floyd Richmond ProTools Tutorial</td>
<td>51</td>
</tr>
<tr>
<td>Rocky Reuter ProTools Tutorials</td>
<td>54</td>
</tr>
<tr>
<td>Appendix 4: Supplemental Materials</td>
<td>70</td>
</tr>
<tr>
<td>Digital Audio Supplemental Sheet – Multimedia Integration</td>
<td>70</td>
</tr>
<tr>
<td>Appendix 5: Tom Rudolph Digital Audio Presentation Outline</td>
<td>73</td>
</tr>
</tbody>
</table>
**Description**

Digital Audio (TI:ME 2B) covers various techniques for recording, editing and storing sound. Entry level and professional recording equipment will be used. All audio projects will be burned to CD or other high quality medium but sounds will also be converted to compressed formats such as MP3 for use on the internet. Inservice teachers (ISTs) who complete this course will created several recordings with mixing occurring in analog and digital realms. The materials developed will be appropriate for music instruction in the K-12 classroom. Software to be used in the class will include programs for recording in one pass, for recording and editing two tracks, for recording and editing multiple tracks, and for burning to CD or other high quality medium. The format of the course will alternate presentations with class activities in which student progress is assessed and in which the material presented is reinforced. Evaluation will be through written homework, completion of class projects, and the submission of a final project demonstrating techniques learned in class. This course meets one third of the coursework requirements for Level Two TI:ME Certification. Prerequisites for this course include completion of both TI:ME level 1 courses OR equivalent experience.

**Additional Information**

Digital Audio (TI:ME 2B) may be offered as a two-credit or three-credit graduate course. Topics in ALL CAPS within the outline need not be included when it is offered for two graduate credits only. The instructor of this course must be approved by TI:ME and experienced in teaching technology to inservice music teachers. This course will serve a maximum of 16:1 teacher/student ratio. Additional students may be accommodated if additional workstations and teacher assistants are available. Each IST will need approximately 20 hours working alone at a workstation in order to complete class activities and the final project.
**Hardware Requirements**

A computer lab/classroom consisting of up to sixteen student and one teacher's computer/music workstation is the required minimum configuration. The classroom must have the ability to connect to the Internet, with direct LAN access a plus. Each participant must have access to a private workstation consisting of a multimedia-capable computer, MIDI keyboard, and audio support equipment including a CD and/or DVD burner. The teacher’s station should be connected to a projection device and all student and teaching stations should be connected to an audio playback system for class evaluation of each other's work. Hardware for recording and editing digital audio such as microphones, mixers, digital to analog converters, CD and/or DVD burners should be available to students.

**Software Requirements**

This course requires the following software:

- Single pass recording software such as Sound Recorder (optional).
- Looping Software with digital audio such as Garage Band, Fruity Loops, or Acid. (optional)
- Dual track recording and editing software (optional)
- Multiple track recording and editing software
- CD or DVD burning software

All software choices (or equivalent programs) should be available for Mac OS and Windows platforms. Numerous programs can be used to complete the requirements of this course. This handbook presents screen shots and explanations of techniques which may seem to favor one program or platform over another. TI:ME does not endorse or prefer any specific program but encourages instructors to use modern and effective software. Appendix 1 provides a list of digital audio programs.
Digital Audio

Introduction
The outline is designed for a 30 hour unit on creating and editing digital audio within a 2 credit graduate workshop. Items in UPPERCASE can be added if the course is offered for 3 graduate credits. The primary objective of this section is to instruct ISTs in skills in creating digital audio. The instructor will also provide ISTs with the information they need to plan educationally valid integration of digital audio into their teaching and legal usage of digital audio. In addition to satisfactory completion of class projects, a digital audio project is required for certification.

Prerequisites
Enrollees in this course should have computing skills at the level of word processing and familiarity with a graphic user interface (Windows or Macintosh OS). Prerequisites for this course include completion of both TI:ME level 1 courses OR equivalent experience.

Objectives
Declarative Knowledge
The IST describes several ways to use digital audio to enhance teaching and learning. The IST identifies and describes copyright issues applicable to digital audio.

Procedural Knowledge
The IST demonstrates basic skills in using software tools for recording and editing digital audio and saving it to a suitable high quality format such as CD for use in the classroom. The skills to be acquired include the following:

- Recording original digital audio files
- Editing digital audio files
- Transferring digital audio to a suitable playback medium such as CD or DVD.
Assessment

The IST completes the class worksheets on creating digital audio, including microphone selection, microphone placement, and room acoustics. The IST completes all class recording projects. The IST creates a digital audio project useful for the classroom. The project will be evaluated in terms of its professionalism, suitability, and creativity.
Digital Audio

SUMMARY OF COURSE TOPICS

(1) The first recording
(2) The first CD
(3) Record a piano accompaniment and a solo (stereo record) and burn to CD.
(4) Record a duet using two track (stereo) recording software and burn to CD.
(5) Record a quartet using multi-track recording software and burn to CD
(6) Setup activity and discussion
(7) Acoustic Considerations
(8) Record class/small chamber ensemble, - Bring Instruments, Materials required – arrangements for class performance
(9) Record class/ small vocal ensemble, - Bring Instruments, Materials required – arrangements for class performance
(10) Editing project 1
(11) Editing project 2
(12) Editing project 3
  Extremes -tasteful use
  Compression
  Filtering/EQ
  Normalization
  Fade In/Out
  Reverb/Delay
  Panning
  Pitch Correction
(13) Converting Recordings in One Format To Another
(14) Final project
(15) Digital Audio and Copyright
(16) Digital Audio and the MENC National Standards
Digital Audio

Topic 1 – The first recording:
The instructor will explain why music teachers might want to use digital audio.
- Recording student practice sessions and rehearsals for evaluation
- Recording CDs
- Recording live concerts
- Developing a Recording Studio in the school
- Fund raising (see the section on copyright)
- Electronic Audio Portfolio (scales mastered, pieces mastered, etc.)
- Accompaniments

The instructor will demonstrate the following:
- Recording using simple recording software, two-track software, or looping software.
- Details of the available hardware and software.
- Microphone connection and placement.
- Setting the software input
  - Most computers can record from a number of sources.
  - Obviously, the computer must record the correct input.
- Setting the input level.
- If the incoming signal is too soft, the signal will not be of the best quality. Every recording contains some noise from the room or equipment. If the signal is not loud enough the signal-to-noise ratio will be too high for a quality recording. If the signal is too loud, parts of it will be destroyed.
- Setting the sample depth and rate. (See the fact sheets on the next pages.)
- Recording a perfect performance.
  - The best approach, even if equipment permits multiple takes and edits, is to record an excellent performance on the first try.
- Saving the file.
  - The instructor will direct the students in how to save the file and in which format.
  - In the next lesson, this file will be burned to CD so the file must be saved in a format appropriate for the hardware and software being used. The most common formats for burning to CD are WAV and AIF.
  - Files may also be saved in a format such as MP3 which permits the file to be placed on the Internet, or saved to an MP3 player.

Class Activity – Recording a simple audio example such as a counting to ten, a poem, piano piece, or solo vocal piece.

Notes:

Recording: Because some errors cannot be corrected by editing it is best to start with the best possible performance and recording. Of highest importance are the input levels. The signal being recorded must be loud enough but not too loud. The “needles” should not move into the red.
The following concepts are important when recording digital audio on the computer.

A. Sound Source and Input-
   Sound input may be from a microphone, electric guitar, synthesizer, tape player, or any device which produces an appropriate electronic signal. Check the level of sound coming in since many of these devices send out stronger or weaker signals than the others. Signals from a microphone or a low-impedance “Direct Box” require a pre-amplifier to bring the signal (-40db) up to “line level” (0 db). Signals coming from guitars and keyboards produce a line level signal and no pre-amplifier is necessary.

B. Sample Depth (eight, sixteen, twenty-four bit)
   When sounds are converted to a digital format, they are commonly saved with eight, sixteen or twenty-four bits of precision. Saving with sixteen bits produces an accurate representation of the original sound. Sixteen bits is standard “Redbook” CD quality. All consumer level CDs use sixteen bits. Twenty-four bits (or more) may be used if the project will always exist on hard drive or if it will be burned to a format such as DVD which supports higher quality. Saving at eight bits is acceptable for low-fidelity speech on the internet where file sizes are critical.

C. Sample Rate-
   A sampling rate of 44,100 times per second is used if the music will be saved on a compact disc (CD). This sample rate eliminates most annoying acoustic phenomena such as pitch shifts and noise (at least for humans, dogs may still be able to detect some loss of quality due to the sample rate). When recording for DVD, a sampling rate of 48K is frequently used. When recording music for the internet, a sampling rate of 20,000 is acceptable. When recording speech only a sampling rate of 8,000 per second is adequate.

D. Monaural, Stereo, or Surround Sound Recording
   Sounds to be written to DVD may range from mono (one track) to 5.1 surround sound (five independent tracks). Sounds to be written to CD must be in stereo format (two tracks). Since file size is such a significant issue for internet users, monaural recordings are frequently used when sounds will be placed on the internet. With the advent of high-bandwidth internet services, however, stereo recordings are becoming increasingly commonplace.
E. File Size and Compression-
   Depending on the software used, there may or may not be an option which allows the sound to be compressed. Some loss of sound quality occurs with all compression schemes. Experiment but keep a copy of the original so you can revert if necessary. When saving files for the internet it is important to produce files which can be played on Macintosh or Windows computers. Choose compression which can be realized on both platforms. Converting files to MP3 allows for excellent compression while retaining quality sound. MP3s also support several levels of compression.

F. File Types
   • .wav – The WAVE format originated on the Windows platform. It supports a number of sample rates, depths, and compression schemes. Today it is used on all platforms.
   • .aiff – The Audio Interchange File Format (.aiff) originated on the Macintosh platform. It supports a number of sample rates, depths, and compression schemes. Today it is used on all platforms.
   • .mp3—As of this writing mp3s are the most common compressed music files. They are supported by numerous online music services as well as most personal music players. Some CD players will play mp3s from data CDs. This extends the amount of music that can be placed on a single CD from about an hour to tens of hours.
   • .aac – As of this writing, the AAC format is one of the newest. It is supported especially by the iTunes music store and new iPods.
   • .wma – Windows Media Audio

G. Other Tips-Internet
   -When file size is a concern
     Use MIDI files for music.
     Use MP3 files for digital audio.
     If WAV, or AIF files are used, sample at the lowest acceptable rate.
     Keep samples short (a few seconds is best).
     Remove silence and/or noise at the beginning and end
     Avoid compression schemes which work only on one computer platforms.
Some instructors may wish for the first recording experience to be with a basic sound recording program such as those shown below. Use the software directed by your instructor.

**Recording Sound (BASIC)**

On Macintosh and Windows Computers

Dr. C. Floyd Richmond  
Department of Music  
Valley Forge Christian College  
Phoenixville, PA 19460  
frichmond@vfcc.edu

Windows users will find a sound recording program built into Windows 95 and higher. It is entitled Sound Recorder and may be used to record sounds and perform basic editing. Sound Recorder reads and writes wave (.wav) files which are appropriate for immediate posting to the internet or for use in QuickTime and multimedia projects.

Macintosh Users may use GarageBand (comes with current Macintosh computers) or QuickTime Pro ($30 but well worth it for all of it’s other features). Both export a variety of file types (.wav, .aif, .mp3) for use in multimedia projects or use on the internet. Below are screens from QuickTime Pro.

Sound Recorder also supports a number of sampling rates and other recording options. These are selected by choosing Audio Properties from the Edit menu.

QuickTime Pro exports files with a number of sampling rates, bit depths, and compression settings.

Editing features include cropping the sound, mixing the sound with others, amplifying the sound, making the sound softer, adding an echo, and reversing the sound. Editing features are available by choosing the desired options from the Edit and Effects menus.

QuickTime Pro allows sound to be recorded from a number of sources as set in the System’s Sound Control Panel.

QuickTime Pro also allows cut and paste editing, overlaying of audio and video tracks, and adjustments to gain and EQ.
Topic 2 – The first CD:
The instructor will demonstrate the following:

- Running software for burning CDs
- Setting the format to audio CD (if required)
- Loading the file(s) to be burned
- Editing the list
- EDITING TIME BETWEEN TRACKS
- Discuss CD media formats (CDR, CDRW)
  - **CDR** stands for CD-Record Only. It supports the audio CD format and several others (saving data, for a computer, for instance). A CDR disc can have data recorded to it only once. Once the data is written it cannot be changed. Some systems support writing the data to the CD in multiple sessions but many audio CD players cannot read them when written in this manner. It is best when creating audio CDs to burn them in one pass only.
  - **CDRW** stands for Read and Write. It also supports the audio CD format and several others (saving data, for a computer). Data written to these CDs may be written and erased again and again. Some audio CD players cannot play these CDs. When saving audio to CDRWs, it is best to plan to use them in a computer or a player known to support them.
- Burning the CD. (The instructor will guide the student through the process of burning the CD.)

Class Activity – Burn the previous piece to CD

Notes:

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
NOTE: iTunes is a cross-platform program which supports the burning of audio CDs. The directions below will work on any modern computer with a CD burner. Always use the most recent version of iTunes. Your instructor may direct you to use other software such as Roxio’s Toast and Jam (Macintosh) and EZ CD Creator (Windows).

### Burn a CD with iTunes

Dr. C. Floyd Richmond  
Department of Music  
Valley Forge Christian College  
Phoenixville, PA 19460  
frichmond@vfcc.edu

You’ll need: a recent version of iTunes and a computer with a CDRW drive supported by iTunes.

1. First, record all songs to be included on the CD using digital audio software. Each song will consist of a single 16 bit, stereo, 44.1khz, digital-audio file created by the digital audio software in a “bounce to disk” or, sometimes, a “save” operation.

2. Run iTunes.

3. Create and open a new playlist.

4. Drag the songs to be included on the CD into the playlist in the desired order.

5. Click the Burn button at the top right of the screen. Insert a blank CDR as prompted. Click the “Continue/Burn” button.

6. Wait for the operation to complete. The speed will depend on the speed of the CDRW drive in your computer.

NOTE: Use CD-R discs (burn one time only) for compatibility with a greater number of consumer audio CD players. CD-RW discs will work in some, but not all, players.

NOTE: iTunes is cross platform and recent versions support the features shown on this page. Platform specific equivalent tools include Roxio’s Toast and Jam (Macintosh) and EZ CD Creator (Windows).
Topic 3 - Record a song using looping software and burn to CD.

The instructor will demonstrate the following:
- Using software with pre-recorded loops such as Garage Band or Fruity Loops.
- Creating a CD of the recording.

Class Activity – The class will use looping software to create an original composition, share it with the class, and record it to CD.

Notes:

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Topic 4 -RECORD A PIANO ACCOMPANIMENT AND A SOLO (STEREO RECORD) AND BURN TO CD. Review the process for placing microphones for recording. Discuss phasing as an acoustic phenomena and it’s implication for recording.

The instructor will demonstrate the following skills, this time using two-track recording software:

Note: Many studio engineers use two track software for a number of reasons (stronger mastering capabilities, easier interface, etc.). The instructor will direct you on the software to use for this assignment. Those using multi-track software may wish to use only two tracks for topics three and four.

- Running a two-track recording program.
  - These programs typically permit recording and editing.
  - The performer may record different materials in the left and right tracks.
- Setup (as before)
  - Microphone connection and placement (cover placement for various pianos).
  - Setting the software input
  - Setting the input level.
  - Setting the sample depth and rate.
- Enabling a track for recording.
- Recording a performance section by section.
- This software should permit the student to record into the same track starting at different times.
- Saving the file and burning to CD.
  - This will probably be the same process as before.
  - Some software, however, may permit burning the CD directly.
  - Playing the CD with the balance all the way left, right, and in the middle.

Class Activity – The student will record a piano accompaniment in one track and a solo in another and burn the recording to CD.

Notes:
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
**Editing:** Any number of digital audio programs can be used to record and edit digital audio but most have a number of common features. The following programs are frequently used for both recording and editing on the computer: ProTools, Digital Performer, Logic, GarageBand, Audition, Cakewalk, and Cubase.
Piano Microphone Placement

An important consideration when recording pianos is whether to use one or two microphones. One simplifies the process and would be appropriate for topic 4. Still one microphone does not always capture the full characteristic sound of the piano. Two are generally recommended. Using two microphones, however, sets up a situation where “phasing” can occur. If unusual variations in the sound occur in the mixed tracks (increasing and decreasing volume) then partial phasing is occurring. In perfectly out of phase recordings, two tracks can cancel each other. In the event of phasing, the better sounding piano track may be used, the phase of one of the tracks may be adjusted with the digital editing software, or the microphones may be repositioned for another recording. The latter would be preferred.

**Upright Piano:** Record with microphones placed as shown below.

Record close to the soundboard if the lid must remain closed. Place microphones about a third of two mics about a third of the way from each end and about half way up the of the keyboard and about twelve inches above the keyboard.

**Grand Piano:** There are several approaches to recording a grand piano with two microphones.

For a full and powerful piano sound, place the microphones about six inches above the hammers. Space them so that one covers the middle of the lower notes of the keyboard. Place the other so that it covers the middle of the upper notes of the keyboard. Placing the microphones at an angle insures a different signal in each. This technique is most used for popular music or rock.

For quiet and lyric pieces, place the microphones at an angle with one facing the end of the piano with the keys and the other facing the opposite end of the instrument. Raise the lid and place the microphones about eighteen inches above the strings. Extend the microphones about a foot into the instrument. This technique is most used for quiet jazz or popular music. Note: These microphones are angled at 45 degrees. Because they are placed pointing into the body of the piano, the exact angle of placement is hard to see.

For a classical sound, set the microphones six to eight feet high (depending on the room) about six feet away from the piano. Record the sound of the room as well as the piano (use appropriate microphones). This technique is most used for recording classical piano in a large hall.
Phasing, which is mentioned on the page above, is an acoustic anomaly which occurs when two identical or nearly identical sounds are recorded but, with a very slight offset in time. In perfectly out of phase recordings, the mix of the two will cancel each other. See the figures below.

![An original recording](image1)

![An original recording](image2)

![An original recording](image3)

A perfectly out of phase recording (impossible to generate naturally).

A partially out of phase recording (fairly common with closely spaced microphones).

A track slightly out of tune with this track.

The recording which results from a mix of the tracks above: Silence!

The recording which results from a mix of the tracks above. Notice the reinforcement of sound caused by phasing in this example actually caused clipping (part of the signal was so loud it was out of range).

The result of mixing the tracks above. Notice the loud outer part of the wave and the soft inner part. Intonation problems are evident to listeners as pulses in the sound because of the shifting location of phasing reinforcement and cancellation!

It is essential to listen to the mix of similar tracks to see if undesirable phasing has occurred. Listening to the mix is the only way to determine if phasing is a problem.

Phasing is sometimes applied to recordings intentionally for effect. Obviously this must be done with care. Some guitar boxes have “phaser” effects that have an attractive combination of phasing and other effects.
Topic 5 - Record a duet using two track (stereo) recording software and burn to CD.

The instructor will demonstrate the following:
- Recording the duet.
- Copy and paste operations.
- Creating a CD of the recording.
- THE INSTRUCTOR MAY ASK THE STUDENT TO CREATE SEVERAL RECORDINGS OF THE DUET ON THE CD BUT WITH EACH MIXED DIFFERENTLY (AS INDICATED BELOW):
  - TRACK 1 OF THE CD CONTAINS ONLY VOICE 1 IN BOTH THE LEFT AND RIGHT CHANNELS.
  - TRACK 2 OF THE CD CONTAINS ONLY VOICE 2 IN BOTH THE LEFT AND RIGHT CHANNELS.
  - TRACK 3 CONTAINS VOICE 1 IN THE LEFT CHANNEL AND VOICE 2 IN THE RIGHT CHANNEL.
  - TRACK 4 CONTAINS VOICE 1 AND 2 EQUALLY IN BOTH LEFT AND RIGHT CHANNELS.

Class Activity – The class will record a duet and burn a CD, WITH FOUR TRACKS AS DESCRIBED ABOVE.

Notes:

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Topic 6 - Record a quartet using multi-track recording software and burn to CD

The instructor will demonstrate the following skills, this time using multi-track recording software: Note: If you have not already done so, you will now begin using multi-track recording software. Recording in layers and multiple passes is greatly enhanced with this software. This software is typically marketed toward a more professional audience and therefore usually includes increased editing features.

• Running a multi-track recording program.
  • These programs may require the setup of tracks to be recorded.
• Setup (Microphones, inputs, levels, sample depth and rate)
• Enabling a track for recording.
• Saving the file and burning to CD.
• Recording a quartet and burning it to CD.

Class Activity – The class will record each voice of a quartet into a separate track in multi-track recording software. The class will burn the recording to CD. THE INSTRUCTOR MAY ASK THE STUDENT TO BURN THE CD WITH THE TRACKS MIXED AS FOLLOWS:

• TRACK 1: ALL FOUR VOICES EQUALLY BALANCED IN LEFT AND RIGHT CHANNELS.
• TRACK 2: VOICE 1 IN THE LEFT CHANNEL. VOICES 2, 3, AND 4 IN THE RIGHT CHANNEL.
• TRACK 3: VOICE 2 IN THE LEFT CHANNEL. VOICES 1, 3, AND 4 IN THE RIGHT CHANNEL.
• TRACK 4: VOICE 3 IN THE LEFT CHANNEL. VOICES 1, 2, AND 4 IN THE RIGHT CHANNEL.
• TRACK 5: VOICE 4 IN THE LEFT CHANNEL. VOICES 1, 2, AND 3 IN THE RIGHT CHANNEL.

Notes:
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Topic 7 - Setup activity and discussion.

The instructor will demonstrate and discuss additional hardware setup issues including the following:

- The recording approach (analog, digital at various stages).
- Setup is a most critical step. Ensembles typically run through their program one time. If there are any problems with levels or hardware, there may not be another chance to record the performance. A sound check is critical prior to the performance.
- Selecting appropriate microphones for the recording application. See the fact sheet on the following pages.
- Decide on microphone placement
- Connecting microphones to mixer inputs
- Adjusting the EQ on the mixing board.
- Adding additional effects units to the mixing board.
- Following signal path through endpoint
- Setting the appropriate gain and trim on the mixing board.
- Eliminating peaking or clipping
- Creating clear channels with no noise

Class Activity – The class will take turns using the available equipment to set up to record an instrumental ensemble, a choral ensemble, and a contemporary popular ensemble.

Notes:

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

TI:ME 2B Digital Audio
Notes: The diagram below shows a typical recording setup. In this illustration, the sound of the ensemble is received by the two microphones, sent through two channels of the mixer then to the audio inputs of the computer where it is converted to a digital audio file which can be burned to CD or prepared for the web. If it is the intent to broadcast the entire concert from the web at once, everything can be saved into one file. If the songs will be burned to CD, or if visitors on the web will have access to the concert, song by song, it would be better to save each song as a separate file.

Typical Recording Setup
HARDWARE SETUP AND DETAILS

Microphones:

Microphone Setup
• Get a good microphone stand
• Height and location of the microphone make a difference in the quality of the recording
• Instrumental Microphone Placement
  • Place the microphone at twice the height of the instrumental ensemble
  • Place 1/3 in on both sides
• Choral Microphone Placement
  • Place microphone at eye height of top row
  • Place 1/3 in on both sides
• Point microphone down at about 15 degree angle

Microphone Selection
• Uses Condenser for concert recording (Audio Technica Stereo Condenser Microphone)
• High End Microphones
  • Changeable patterns
  • Multi-purpose – larger diaphragm for vocals and soft volumes

Each recording task requires a different microphone.

Wind ensemble and Orchestra – large diaphragm, condenser, cardioid pattern
A popular microphone is the AKG C200b As of this writing the street price is about $200 (list $482).

Jazz ensembles – condenser, cardioid
A popular microphone is the Shure SM81 – about $329

The Jazz ensemble frequently uses multiple microphones as follows;
  • solos -condenser, cardioid such as the Shure SM57 – about $100
  • kick drums and bass -large diaphragm tuned for low frequencies
    such as the AKG D112 about $200

Chorus – condenser, cardioid (such as the Shure SM81)

Chamber ensemble – condenser, cardioid (such as the Shure SM81)

Contemporary ensemble (popular music)

Vocal – condenser mic, cardioid
  • such as the Shure SM81
  • such as the Sennheiser 835 about $100

The Sennheiser is a dynamic microphone requiring no power.
All others require phantom power

Drums –

• Kick drum: D112
• Snare drum and toms: SM57
• Cymbals: place microphone such as the SM81 for overhead

Any microphone with similar characteristics may be substituted for these. Neumann makes excellent microphones in the $700 to $3000 range.
THE RECORDING APPROACH
ANALOG AND DIGITAL STAGES:

Analog approaches – digital – last possible moment
- Microphones to analog mixer to a two track digital recorder
- Microphones to analog mixer into computer

These approaches requires a good sound man during the actual recording because only limited editing is possible after the recording.

Digital realm immediately – mid to low range with equip. – consumer level

Mics to Digital Audio Workstation (DAW)
- multiple inputs
- built-in mixer
- hard disk recording
- on-board editing
- on-board burner.

Mics to DA Interface into computer
- multiple inputs -8 to 16 channels
- mixing on computer
- Records to computers hard drive
- Editing is through computer software
- computer burns to CD

Mics to external digital mixer, to hard drive
- multiple inputs
- built-in mixer
- hard disk recording
- on-board editing -mix is done there
- on-board burner.
THE RECORDING APPROACH:

This page contains examples of hardware for each category and subcategory of computer-based and stand-alone recording devices.

**Computer Based Recording**
- Basic computer microphone
- USB adapter permitting microphone or line input into the computer (such as iMic)

**Two channel computer interface**
- M Box
- M Audio Firewire 410
- Mackie Spike
- PreSonus Firebox

**Multi channel interface with USB or FireWire connection**

<table>
<thead>
<tr>
<th>Input</th>
<th>Hardware</th>
</tr>
</thead>
<tbody>
<tr>
<td>4+ Input</td>
<td>Lexicon Omega Studio, M Audio FireWire Solo, Edirol FA-66, PreSonus, Focusrite</td>
</tr>
<tr>
<td>8+ Input</td>
<td>MOTU HD896, Digi002, M Audio 1814, FIREPOD, OctoPre</td>
</tr>
</tbody>
</table>

**Multi channel interface with PCI card interface**
- MOTU 2408mk3
- MOTU HD 192
- Pro Tools HD TDM Systems

**Stand Alone Recording Units**

**Flash Recorders**
- Marantz PMD660
- Marantz PMD671
- Roland CD-2
- Edirol R-1

**CD Recorder (Non Computer)**
- Super Scope
- Roland CD-2
- HHB CDR830
- Marantz CDR510
- Edirol R-4

**Multi track digital tape recorder**
- Alesis ADAT HD 24
- TascamDA 98 HR

**Multi track hard disc recorder**
- TascamDP-01
- KorgD1200mkII
- KorgD16XD
- KorgD32XD
- RolandVS-2480DVD
- RolandVS-2000CD
- AKAI DPS24

NOTE: Specific hardware and manufacturers mentioned on this page are for illustration only. Excellent results are possible with other models and with hardware by other manufacturers.
**Topic 8 - Acoustic Considerations.**

The instructor will discuss acoustic considerations of recording spaces. The instructor will review the clap test with students (see below) and the process for calculating the reverb time for an auditorium or other recording space.

**Class Activities –**

The class will review the fact sheets on the following pages.

The class will participate in a discussion of recording space acoustics.

The class will walk around the building and execute the “clap test” in various locations: stairwell, practice room, hallway, classroom, gymnasium, etc. Open and close curtains on the stage to see the effect. Listen to and describe sounds.

The class will calculate the reverberation time of their auditorium and/or the class recording space.

**Notes:**

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________
Acoustics of Recording Spaces

Claptomania (Vince Leonard)

Before attempting to record in a space it is essential to analyze the reverberation characteristics of that space. The quickest way to accomplish this is to use a simple, sharp clap of the hands. The sound waves from the clap will bounce around the space and return to your ears over time. The larger the room the longer it will take for the sound waves to bounce around and dissipate over time. The sound you hearing is divided into two parts or sounds, early reflections and late reflections. Early reflections are well defined and establish the position of the sound source in the room and the room’s characteristics, composition of the walls, floor and ceiling. Late reflections define the size of the room. These occur at less regular intervals as the sound waves decay.

Begin the clap test in your auditorium. Try it at different positions on stage and in the seating area. Try closing the curtain, first partially, the fully and not the difference as an absorptive surface is introduced to the space.

Try the clap test in other spaces around the building, a stairwell, classrooms and especially the gym. Note the characteristics of each space as they relate to the materials used in the construction of the room. Hard, reflective surfaces like cinder block or concrete will reflect more sound than wood. Note the affect of more absorptive materials such as curtains have on the sound and how that may change as they are opened and closed.

What this test will help you determine is the quality of the space for recording and how this will effect microphone positioning to get the best sound. If you hear several distinct early reflections (echoes) of the clap, this sound is called flutter echo. The sound waves are bouncing off of the hard, reflective surfaces of the room, walls, floor and ceiling, and back to your ears several times in rapid succession. This sound is very unflattering and will ruin a recording. If using another space is not an option, bring in as much absorptive material as needed to eliminate the flutter.

Positioning microphones properly is key for a good recording. Positioning them too far back from the ensemble will reduce the early reflections recorded and result in a distant, roomy sounding recording. Positioning them too close may eliminate the late reflections and loose the natural blending of the space.

The room will be a big part of your recording, discovering and using its best qualities, while eliminating its less flattering qualities will help you achieve successful recordings time after time.
Acoustics of Recording Spaces (Building or Decorating with Recording in Mind):
Lee Bilotta

The most important acoustic consideration is the room reverberation time, or how live or dead the room is. If the room has an excessive echo, materials like curtains, polyurethane foam products can soften it. Rooms are seldom too dead but if so, the problem may be corrected by placing hard panels behind the sound sources.

Reverb considerations for ensembles:
It is important that the acoustic space be appropriate for the ensemble being recorded. Large ensembles and loud instruments require a space with less reverb. Small ensembles or quiet instruments require more.

The following ensembles require very little reverb.
- Percussion Ensemble
- Wind Ensemble
- Jazz Ensemble
- Orchestra
- Large Choral Groups
- Opera

More reverb is required for the following ensembles.
- Chamber ensembles
- Small vocal groups
- Acoustic Guitars

Style is also a factor in the reverb desired in the recording space.
- Baroque – less reverb
- Early Classical – more reverb
- Late Classical and Romantic – even more reverb

Reverb when Editing: While the characteristics of the recording space are important, it is also necessary to consider the space in which editing will occur. If it is the same room in which the recording was made, and the editor is listening to the sound in speakers, it is sometimes easy to confuse the natural reverb of the room with the actual recording. Making editing decisions under these circumstances sometimes produces less than ideal results. Editing in good flat response headphones, and/or an acoustically quiet space (little or no reverb) helps the editor make the best decisions.

Technical Considerations
Reverb times may be calculated in a manner which help determine if the space is appropriate for recording. A reverb time from .8 to 2.5 seconds is required for a good recording depending on the style of the music. Romantic and Classical music work best at 1.5 to 2.5; jazz from .75 to 1; and choral from 1 to 2. Reverb time is calculated using the following formula:

\[ \text{Time} = 0.05(\text{volume} \times \text{sabines}) \]

Volume is total cubic feet of the recording room. Sabines are the total noise reduction coefficient (NRC) units calculate by the surface area of the room. Every building material has an NRC rating. NRC * total square footage of materials in the room.
Sheet rock | .05
---|---
Carpet | .27
Glass | .01
Auralex Foam (designed for acoustic damping) | .80
Ceiling tiles | .43
Concrete blocks | .04
Concrete floor | .03
Curtains (average) | .5

For a ten by ten space a typical sabine rating might be calculated as follows:

| 100sq ft floor | *.27 carpet | = 27 |
| 400 sq ft wall | *.05 sheet rock | = 20 |
| 100 sq ft ceiling | *.43 ceiling tiles | = 43 |
| Total Sabine Units | | = 90 |

Using the formula above, the reverb time may be calculated as follows:

\[
\text{Reverb time} = 0.05 \left( \frac{1000 \text{ cubic feet}}{90} \right) = 0.56
\]

**Other Acoustic Considerations of Recording Spaces**

Untreated parallel walls with hard surfaces in large spaces create "slap" echos which would offend the ear of most musicians.

Ceiling heights that are too low are not conducive to quality recording because low frequencies can't develop in the space. Timpani and Tuba wave forms may not physically fit in small rooms.

Rooms which are too large or too empty create additional reverb, reflections, and echoes.
**Topic 9 – Record the class or a small chamber ensemble.**
The instructor will demonstrate the setup and preparation for recording a small chamber ensemble.

THE INSTRUCTOR WILL ASK STUDENTS TO BRING INSTRUMENTS AND/OR ARRANGEMENTS FOR RECORDING.

Class Activity –

The class will engage in a discussion of the setup and preparation for recording chamber ensembles.

THE CLASS WILL RECORD A SMALL CHAMBER ENSEMBLE MADE UP OF CLASS MEMBERS.

Notes:

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Recording a Chamber Ensemble

The setup below is a very workable for chamber ensembles, although the dimensions may need some adjustments. See the suggestions below.

Typical Recording Setup

Assemble the equipment needed:
- Microphones
- Stands and booms
- Microphone cables
- Mixer (if required)
- Headphones
- Power strip
- Extension cords
- Recording hardware and/or computer

For a classical chamber ensemble, microphones should be condenser types with a wide, flat frequency response (see recommendations under the discussion in topic 7). When setting up for the recording, listen to the sound which will be recorded in the headphones ahead of time to make certain that everything is ready. Continue to monitor the signal being recorded during the recording process. When the recording is happening in the same space as the performance (usually) there is a danger of confusing the signal being recorded with the actual performance. A pair of headphones which blocks room sounds is essential.

Microphone Placement: Place the microphones about ten to twelve feet in front of the ensemble near the center of the ensemble. The microphone stands should be above the ensemble on stands about ten to twelve feet high. Angle the microphones away from each other but toward the ensemble, pointing downward.

Soloist Microphones: It may be necessary to place a microphone separately on soloists performing with the group. If the soloist and the ensemble can be recorded into separate tracks, greater control over balance can be achieved in the final recording. Otherwise, care must be taken to achieve a good balance during the recording. Tracks in which soloists have been recorded may need some adjustments to achieve optimum balance and time synchronization with the ensemble.
Topic 10 – Record class/ small vocal ensemble

Materials required – arrangements for class performance

The instructor will demonstrate the setup and preparation for recording a small vocal ensemble.

Class Activity – The class will record a small chamber ensemble made up of class members.

Notes:

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Topics 11, 12, 13 – Post Editing project

The instructor will demonstrate the following over the course of several lessons.

- Tasteful use of tools (avoiding extremes)
- Compression
- Filtering/EQ
- Normalization
- Fade In/Out
- Reverb/Delay
- Panning
- Pitch Correction

The instructor will review the vocabulary/glossary with the class. The instructor will review the fact sheet on the following pages with the class.

Class Activities

The class will participate in instructor led discussions of editing techniques. The class will open existing projects and create new versions using the editing techniques and criteria specified by the instructor.

Notes:

Effects should be treated like seasoning on food. Just the right amount can enhance the quality of the food and make the entire experience more enjoyable. Not enough and the food is bland. Too much, and it can’t be eaten. Likewise, with a recording, the effects can make a good recording into an excellent one. In both cases, it is critical to begin with quality. Just as no amount of seasoning can make a spoiled dish palatable; no combination of effects can make a poor original into a great recording.

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________
**Digital Audio Effects**

**Vocabulary and Glossary**

**Compression:** A compressor, also known as a dynamics processor, is a tool which helps control inconsistencies in the dynamics of the music. A compressor, reduces a signal’s decibel level after determining the signal is above the “threshold” level set by the user. Anything below the set threshold level will not be adjusted. Anything that passes through the compressor that is above the threshold will be reduced at a ratio also set by the user (e.g. 1:1, 1:2, 1:3, etc.). Compressors generally have ratio settings between 1:1 and 10:1. This tool is used regularly in multi-track recording to keep drum tracks, bass guitar and vocals at appropriate decibel levels. Appropriate use of compression should not remove musical dynamics, but should bring them out. Compression may be applied to a track of sound during or after the recording process.

**Cross Fade:** A common transitional technique in digital audio where one sound fades out while another fades in. Although this is a common feature in digital audio, it is most commonly used for speech.

**Filter/Equalization:** Known in the industry as EQ, equalization is the attenuation and amplification of specific frequencies to make the recorded content sound as natural as possible. This is a process applied to a track of sound during or after the recording process. It is roughly equivalent to using an equalizer on stereo equipment – where the bass may be turned up or down and high and middle frequencies can be adjusted. There are a number of specialized filters which have been created for use in recording including low pass (which is useful for darkening the sound of a recording), high pass (which is useful for brightening the sound of a recording), band pass (which is useful for strengthening or reducing instruments or voices in a specific range). These filters sometimes contain settings which allow the frequency to be set and the amount of amplification or attenuation to be set. Frequently these filters may be used in combination with one another, or one after another for complex effects.

**Fade/Fade-in/Fade-Out:** This is the process of increasing a recorded signal from zero Db or decreasing it to zero Db. Fading can be done in real time by adjusting the faders as it is being recorded. It can also be done during editing by using a volume envelope tool or a fade tool. Musically it is somewhat like a crescendo or decrescendo. Frequently in digital audio productions, one voice fades out while another fades in. This process is called a cross-fade and is sometimes automated by the software.

**DeEss:** De-Essing is done by a “De-Essor,” a tool that is applied to a recorded signal, usually vocals, that eliminates harsh “S” and “T” sounds. It has user-defined settings that can select specific problem frequencies. It can sometimes eliminate the annoying hiss found in old recordings or those made with bad equipment.

**Normalization:** This is a process applied to a track of recorded sound. The track is scanned for the loudest spot. If it is less than maximum, the volume is adjusted proportionally upward throughout so that the loudest sound is at maximum or at a specified volume level.
**Reverb**: Acoustically, reverberation is the sound which results from the combination of the original sound and its reflections off walls, ceilings, floors, and other objects in the environment. “Digital Reverb” is the process of adding “room acoustics” electronically to a recorded signal. The goal of reverb is usually to make the signal sound as if it was in a specific room or auditorium. The parameters on digital reverb units are user specified and are almost limitless. Settings include:

- **Pre-Delay** – the time it takes for the reverb to be heard.

The use of reverb should be based on stylistic considerations of the music be performed. Digital reverberation may simulate the sound of a specific acoustic environment or it may be used to create special effects not possible in an acoustic environment. Reverb may be applied to a track of sound during or after the recording process.

**Pitch Correction**: This is a process applied to a track of sound during or after the recording process. After recording it can be used to (1) make out-of-tune notes in tune (or vice versa), or (2) make a low voice sound like chipmunks (or vice versa). When used during recording, pitch errors are removed before they are saved. Two real-time pitch-correction processors widely used are the Antares Auto-Tune and the T.C. Electronics Intonator. These devices automatically correct intonation errors in real-time for any solo vocal or mono instrumental track. They cannot be used for more than one voice at a time. These devices can cause problems if the performer uses pitch variations expressively.

**Time Correction**: This is a process applied to a track of recorded sound. Typically, it would be used when the recording which has to occupy 30 seconds actually takes 35 seconds. This process frequently includes a “pitch correction” feature which can retain the original pitch level of the recording while extending or shortening the length. It is best to use this process as few times as possible on a voice since an accurate undo cannot be achieved by reversing the process. Of course, as with all digital audio edits, it can be undone by reverting to the original.

**Firewire**: high speed data transfer standard.


**Interface**: A device that converts analog signals to digital. Usually support outputs for Firewire and S/PDIF or possibly USB, IDEE or ATA.

**Analog to Digital Converter**: A device that converts analog signals to digital. Usually support outputs for Firewire and S/PDIF or possibly USB, IDEE or ATA.

**Controller**: or **Control Surface**: A device that converts analog signals to digital. The device usually supports outputs for Firewire and S/PDIF or possibly USB, IDEE or ATA. A controller also allows real-time editing of multiple tracks.

**Multi-track**: Recording tracks (layers) of music separately for later editing.
The waveform to the right represents the original recording. Note that the volume levels (represented by the height of the wave) do not use the entire range available.

**Normalize:** Normalizing amplifies the volume of a recording so that it uses the entire range of values. This helps balance the level between tracks on a CD or between songs on a web site.

**Expansion/Compression:** These operations can search through the entire track for very loud and very soft parts and adjust them so that the softs are not too soft and the louds are not too loud. Compare the soft sounds on the right half of this wave with the soft sounds on the right of the one above.

**Silence (Cut):** The beginning of each track typically includes some room noise or coughing. The ending usually includes applause. If desired, these can be removed. If applause starts before the piece ends, it is best to leave it. If silence is found at the beginning of the track, it is also possible to remove (cut) the silence completely so that playback starts immediately.

**Reverb:** Reverb adds resonance to a recording. With ensembles, the recording space usually provides the appropriate resonance. If more is needed, it can be added electronically. The thicker body of the graphic on the right reflects reverb. Caution with this tool is strongly advised because not only can it greatly improve the sound of a performance, it’s poor application can ruin the sound.

**Fade In and Out:** This process brings the volume of the recording gradually up or down at the end of sections. It might be a good idea, for instance to fade out the applause, if the recording stopped before the applause died down naturally. Fading in and out is also useful when making a collage of sounds.

**Header/Tag:** When preparing music for broadcast or the internet, an introduction to be used at the beginning of every piece may be prepared. An example, might be a narrator speaking, “And now, the . . . concert band!” Likewise, some recordings need a closing tag. For example, “You’ve been listening to the . . . concert band. Log into our web site . . . for more music.” It is possible to create these then copy and paste them into each new recording.
**Topic 14** – Post Editing project - Mastering

The instructor will demonstrate the following.

- Mixdown or Bounce of Final Tracks
- Mastering
  - Trim Start and End of Final (Stereo) Tracks
  - Check Dynamic Levels
  - Compression of Final (Stereo) Tracks
  - Filtering/EQ of Final (Stereo) Tracks
  - Other Effects applied to Final (Stereo) Tracks

**Class Activities**

The class will participate in instructor led discussions of mastering. The class will mixdown and master their final project.

Notes:

Mixdown is the combining of multiple tracks into a final format (Stereo for CD). Once the tracks have been combined, it is common to open them, adjust their levels, sometimes apply compression and EQ, and at times add other effects to make the sound more full.
**Topic 15 – Converting one media to another**

The instructor will demonstrate or explain converting one media to another (cassette tape, phonograph, reel to reel, etc. to digital audio/CD)

**Class Activity**
Students will participate on a discussion of converting media from one format to another. **STUDENTS WILL CONVERT AUDIO RECORDING IN ONE FORMAT INTO A DIGITAL FORMAT SUCH AS CD.**

**Notes:**
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Converting Audio Recordings in One Format to Another

Phonograph recordings first appeared in the late 1800s. Tape recordings date from the middle of the twentieth century. Compact discs arrived on the scene in the 1980s. The need to transfer recordings in one format to another is becoming increasingly important. The process is fundamentally the same as all recording and is outlined below.

1. First a suitable player for the recording must be found. If the recording is a phonograph, then a phonograph player is required. If the recording is a cassette tape or reel-to-reel tape, an appropriate players is required. The player should be the highest quality one available.

2. The output of the player must be routed into the input of the recording device (typically a computer or stand-alone recording device). If the player does not have an electrical output (like early wax cylinders) and there is no other player which does, then the only option is to record the sound output through a microphone.

3. The recording must be played while the computer or recording device digitizes the sound.

4. The digital version of the recording is saved to an appropriate file format on a hard drive or mass storage device.

5. The sound file is burned to CD or DVD.
Topic 16 – Final project

The instructor will work with the student to define a final project which is applicable to the student’s teaching.

Describe the final project and how it will be used in the classroom.

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
**Topic 17 – Digital Audio and Copyright**

The instructor will review with the student copyright laws applicable to digital audio:

Notes:

________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Copyright Law

The right of creative people to control the display and circulation of their work is assured by law. Of course when recording and distributing copyrighted works, appropriate permissions must be obtained. The first step would be to contact the publisher of the music directly, explain the use of the songs and request permission. Frequently publishers are willing to grant permission to educational organizations because it helps promote their products. In some cases, however, a royalty payment may be required. In all cases, written permission should be obtained before proceeding. When posting files to the web or recording to a CD, any appropriate copyright statements as indicated in the permissions should be included.

For those who wish to streamline the process of working with multiple publishers, there is another option. The Harry Fox Agency (http://www.harryfox.com/index.html) is the licensing agent of the National Music Publisher’s Association. In a few minutes by phone or online, directors can complete an application describing their use of the various materials. Shortly thereafter, and after paying pennies per song, a license will be sent. This agency is able to obtain many kinds of permissions (recording, broadcasting, etc.) for the works of approximately 27,000 music publishers including the entire ASCAP, BMI and SESAC libraries.

All original works should contain a copyright notice indicating the owner and date of the work. The copyright notice should be placed on the work regardless of whether the copyright has been registered. The owner of the work, however, cannot take legal action unless the copyright has been registered. Copyright applications (fee required) are available online at www.copyright.gov.

For further information, refer to the following Internet sites:

The United States Copyright Law - A Guide for Music Educators
http://www.menc.org/information/copyright/copyr.html

The Digital Millennium Copyright Act
http://www.educause.edu/issues/dmca.html
**Topic 18 – Digital Audio and the MENC National Standards**

The instructor will lead a discussion indicating how digital audio can be used to achieve the MENC National Standards and the TI:ME technology strategies.

**Class Activity –** The class will complete the activity worksheet on the next page.

**Notes:**

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

________________________________________________________________________

**Questions for Consideration:**

Can you design a lesson using digital audio software which illustrates the following:

- homophonic and polyphonic music
- texture
- terraced and graduated dynamics
- articulations
- tone quality
- melodic contour
- consonance and dissonance
- an ostinato
- composing using musical building blocks (loops)
- an interdisciplinary music and science lesson illustrating sound waves
- an interdisciplinary music and math lesson illustrating sin and cos.
- the principle of an octave
- the principle of harmonics and overtones
- why out-of-tune notes pulsate
- form and organization in music
- an interdisciplinary video or musical lesson illustrating the use of music in setting a mood
- how to compose a music concrete piece
DIGITAL AUDIO  
Digital Audio, the National Standards and the TI:ME Strategies for Music Education

Short Answer Activity Sheet

1. Which national standard(s) can be addressed using digital audio?
________________________________________________________________________

2. What specific ways can digital audio be used to address these standards?
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________

MENC Standards:
1. Singing, alone and with others, a varied repertoire of music.
2. Performing on instruments, alone and with others, a varied repertoire of music.
3. Improvising melodies, harmonies, and accompaniments.
5. Reading and notating music.
6. Listening to, analyzing and describing music.
7. Evaluating music and music performances.
8. Understanding relationships between music, the other arts, and disciplines outside the arts.
9. Understanding Music in Relation to History and Culture.

3. Now review the Teaching Strategies listed in the TI:ME technology strategies document. See Appendix A of the Technology Strategies for Music Education. Which ones from the digital audio area are most applicable to your teaching position.

<table>
<thead>
<tr>
<th>TI:ME Tech. Strategy #</th>
<th>Teaching Application</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>_____________________</td>
</tr>
<tr>
<td>2</td>
<td>_____________________</td>
</tr>
<tr>
<td>3</td>
<td>_____________________</td>
</tr>
<tr>
<td>4</td>
<td>_____________________</td>
</tr>
</tbody>
</table>

Describe how you could implement TI:ME teaching strategies in your teaching position:
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
________________________________________________________________________
Appendix 1

Digital Audio
Software Recommendations

Digital audio software is generally in rapid transition and many products come as go as the result of corporate purchases and takeovers. Furthermore, the features of these products vary with time. TI:ME recommends the use of currently available, cross-platform software. Instructors should confirm that these programs meet this criteria.

### Digital Audio Software

<table>
<thead>
<tr>
<th>Publisher</th>
<th>Title</th>
<th>Web Address</th>
<th>Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bias, Inc.</td>
<td>Peak</td>
<td><a href="http://www.bias-inc.com/">http://www.bias-inc.com/</a></td>
<td>Mac</td>
</tr>
<tr>
<td>Sonic Foundry</td>
<td>Sound Forge</td>
<td><a href="http://www.sonicfoundry.com/index.html">http://www.sonicfoundry.com/index.html</a></td>
<td>Win</td>
</tr>
<tr>
<td>Adobe</td>
<td>Audition (Cool Edit Pro)</td>
<td><a href="http://www.adobe.com/products/audition/">http://www.adobe.com/products/audition/</a></td>
<td>Win</td>
</tr>
<tr>
<td>Digidesign</td>
<td>ProTools (family)</td>
<td><a href="http://www.digidesign.com/">http://www.digidesign.com/</a></td>
<td>Mac/Win</td>
</tr>
<tr>
<td>Apple</td>
<td>Logic (family)</td>
<td><a href="http://www.apple.com/logic/">http://www.apple.com/logic/</a></td>
<td>Mac/Win</td>
</tr>
<tr>
<td>Steinberg</td>
<td>Cubase (family)</td>
<td><a href="http://www.steinbergaudio.com/">http://www.steinbergaudio.com/</a></td>
<td>Mac/Win</td>
</tr>
<tr>
<td>MOTU</td>
<td>Digital Performer</td>
<td><a href="http://www.motu.com/">http://www.motu.com/</a></td>
<td>Mac</td>
</tr>
<tr>
<td>Cakewalk</td>
<td>Sonar</td>
<td><a href="http://www.cakewalk.com">http://www.cakewalk.com</a></td>
<td>Win</td>
</tr>
<tr>
<td>Apple</td>
<td>SoundTrack</td>
<td><a href="http://www.apple.com">http://www.apple.com</a></td>
<td>Mac</td>
</tr>
<tr>
<td>ImageLine Software</td>
<td>Fruity Loops</td>
<td><a href="http://www.fruityloops.com">http://www.fruityloops.com</a></td>
<td>Win</td>
</tr>
<tr>
<td>Sony Media Software</td>
<td>Acid</td>
<td><a href="http://mediaoftware.sonypictures.com/products/acidfamily.asp">http://mediaoftware.sonypictures.com/products/acidfamily.asp</a></td>
<td>Win</td>
</tr>
<tr>
<td>Sony</td>
<td>Sound Forge</td>
<td><a href="http://www.sonicfoundry.com/index.html">http://www.sonicfoundry.com/index.html</a></td>
<td>Win</td>
</tr>
</tbody>
</table>

### Hardware/Computer Peripherals

**Digital Audio Interfaces/Control Surfaces**

<table>
<thead>
<tr>
<th>Product</th>
<th>Manufacturer</th>
<th>Web Address</th>
<th>Platform</th>
</tr>
</thead>
<tbody>
<tr>
<td>Digital 8 Bus</td>
<td>Mackie</td>
<td><a href="http://www.mackie.com">http://www.mackie.com</a></td>
<td>Mac/Win</td>
</tr>
<tr>
<td>Control Interface</td>
<td>E-Magic</td>
<td><a href="http://www.emagic.com">http://www.emagic.com</a></td>
<td>Mac/Win</td>
</tr>
<tr>
<td>Studio Controller</td>
<td>Steinberg</td>
<td><a href="http://www.steinbergaudio.com">http://www.steinbergaudio.com</a></td>
<td>Mac/Win</td>
</tr>
<tr>
<td>Focus Right</td>
<td>Digidesign</td>
<td><a href="http://www.steinbergaudio.com">http://www.steinbergaudio.com</a></td>
<td>Mac/Win</td>
</tr>
<tr>
<td>Control 24</td>
<td>WHAT IS MOTU</td>
<td><a href="http://www.motu.com">http://www.motu.com</a></td>
<td>Mac/Win</td>
</tr>
</tbody>
</table>

**Stand-Alone Manufacturers**

- Roland
- Mackie
- Korg
- Superscope
Digital Audio

Jeff Wiles

What do we mean by digital audio? As you probably know, sound travels through the air as minute, rapid variations in pressure which describe the pitch and loudness of the sound. If you were able to see them as they pass through a single point you would see a continuously changing wave. Digital audio is a method of representing the waveforms as a series of discrete numbers. To do this the digital audio recorder takes “snapshots” of the sounds called “samples” to represent the waveforms. When these snapshots are played back at an appropriate speed we hear a continuous sound. The process may be compared to a flip-book or a movie where still pictures are presented in a sequence fast enough to realistically depict motion.

Digital Audio Recording Media

There are numerous storage media for digital audio. The most common is the compact disc. CD recorders are usually used as mixdown machines to record the final product. They come in stand alone recorders and as CD burners for your computer. The next most common form of media is digital audio tape or DAT. These are usually used to record the raw audio to be mixed later on. There are also multitrack DAT that can record more than just two tracks of digital audio. The last of the external media used to record audio is the mini disc. These are small discs that can record 74-80 minutes of digital audio. Because of their small size the audio is compressed which makes the quality not as good as CDs or DATs, but the difference is usually not noticeable on most situations. In fact, mini discs have been used to record audio to be released on commercial CDs and have been used in a number of professional situations. Finally, you may record digital audio on a computer. As computers are becoming faster and more powerful this becoming the standard for recording studios around the world and is making home studios far more affordable.
Microphones

Microphones are the beginning of the recording chain and an important element to quality recordings. The job of a microphone is to translate the moving air waves and pressure created by sound into fluctuating electronic signal levels used by electronic equipment. On the opposite end of the chain is the speaker which translates the electronic signals back into the moving air waves and pressures that we call sounds.

Types of Microphones

Most of the microphones that you will encounter will be of two types: dynamic and condenser microphones. Dynamic microphones are probably the most common type of microphones that you will find. They are dependable, rugged, and are simple to use. You will find that they are widely used in both the studio and in live performance. These are usually the most inexpensive microphones, but beware that they are all not created equal. Condenser microphones on the other hand can be some of the finest microphones available, but they can be quite expensive. These microphones translate sound waves into electrical signals differently than dynamic microphones. Unlike the dynamic microphone the condenser microphone requires a power source to run. The power is drawn from either a battery inside the microphone or by phantom power (a source of power from an external source delivered through the microphone line usually from the mixer).

Response Patterns

The way that a microphone picks up sounds is called a response pattern. The polar response refers to the physical positions of sound that the microphone will pick up. In the diagram to the right you will find a number of response pattern that you could encounter. The frequency pattern refers to the microphone sensitivity to various pitches. In other words the range of frequencies that the microphone could pick up.
Mixers

Next in the recording chain is usually a mixer. The most elementary function of a mixer is taking two or more audio signals and combining them, but a mixer could become the center of recording activities. You can use a mixer to set recording and monitor levels, etc. The list is almost endless. Usually when a person first works with a typical mixer, such as the one pictured to left, for the first time it can be a daunting task. Typical mixers are laid out in the same manner. The mixer is divided into channel strips with each channel with its own set of controls. If you know how to operate one channel strip you can run them all.
To the left is a typical channel strip for a channel with a microphone input. The first knob that you see under the inputs (in this case mic and line levels) is the trim. This allows the signal entering this channel to be adjusted to the optimal level before entering the rest of the channel path. The settings of the trim may vary from mixer to mixer so be sure to look up how the trim works for your particular mixer in its manual. Below the trim are the auxiliary sends. These knobs will tell the mixer how much of the signal to send to outboard equipment such as compressors, reverb units or gates. Next in the signal path is the EQ. The EQ allows you to boost or cut the signal at various frequency ranges. This adjusts the sound of the signal but be careful. Overusing the EQ can make a mess of your sound. Under the EQ is the pan pot. This allows you to adjust the amount of signal sent to the left or right outputs. The two buttons underneath the pan pot are the Mute and Solo buttons. These allow you stop the signal from continuing through the signal path (mute) or allow only that signal to continue and mute the other channels (solo). Finally the last knob you see at the bottom of the channel is the Gain. This knob can also be a fader (common on many mixers). The gain controls the final level of a signal.
Appendix 3

Tutorials for Popular Digital Audio Software

NOTE: TI:ME does not support any specific platform or program.

These tutorials show the operation of typical digital audio programs and are thus useful to users of other programs and platforms.
When MicroLogic runs, the following screen appears.

The top window is the arrangement window.

The bottom window is the transport window.

As with any sequencing program, before recording MIDI, it is important to set the metronome. In MicroLogic, this is done in the Options menu.

It is necessary to select a MIDI instrument for each MIDI track that will be used.

Although, each MIDI track is already assigned an instrument, these may be changed as desired.
To record from a MIDI instrument, click the MIDI track in the arrangement window then click the Record button ( ) on the transport window.

By double clicking on a track of MIDI, notes may be edited in either notation or bubble view.

To record an audio track, click the “R” button beside the audio track then click the Record button ( ) on the transport window. Because recording digital audio generates much data, the computer will ask for a location on the hard drive where the data may be saved.

After recording, the volume and other characteristics of audio and MIDI tracks may be adjusted in the mixer window. (From the Window menu, choose Show Mixer.)

By double clicking on a track of recorded digital audio, effects may be added.
When ProTools Free is first run it explains some of the limitations of the free version of the software. Turn on "Don't Show Again" and click OK.

The first step is to create a new recording session. Choose "New Session" from the File menu. This will create a new project folder. Save it on a drive with plenty of free space.

The computer will next ask for the depth of the recording session. The current standard for recording CDs is 16 bits. DVDs support 24 bit sampling.

The following screens appear. These constitute the work area for the recording session. The window on the top left is the editing window. The window on the right is the mixer window.

The small window at the bottom of the screen is the playback and recording console. The recording session does not yet have any tracks defined so the screens are somewhat blank.

The next step is to create a track into which to record. This is done by choosing "New Track" from the File menu.
Upon choosing New Track, the computer allows the user to choose which type of track. For now, choose Audio Track.

A new track appears in the Edit and Mixer windows.

Turn on the record button for the new track (in either the edit or mixer windows) and record in the transport window. Finally press play to record.

After a digital audio track is recorded it is possible to edit it in a number of ways. Editing is frequently done through the use of the tools at the top of the edit window.

Selection tool - for choosing regions to be cut and pasted, or to add effects such as reverb, equalization amplification, etc.

Hand tool - for editing individual MIDI notes, selecting or moving block of digital audio.

Pencil tool - for drawing missing MIDI notes, or wave-level editing in digital audio.

Zoom tool - for getting a better look at notes in the edit window.

To edit digital audio, first use the selection tool to specify a region then choose an option from the Audio menu. Many of these edits can result in significant improvements to the sound (of course some can have little effect and some can make it worse).
Windows for several of the effects are shown below.

Here is a digital audio track before and after normalization: (Note: the recorded level on the left indicates too low of an input signal during recording. Normalizing will amplify the sound but will also amplify the naturally occurring noise in the room and equipment. A track recorded at the level on the left should be rerecorded).

Before burning a CD, all voices must be combined into a stereo file. This is done through the following steps:

1. Mute any tracks that will not be included in the final Mix.
2. Choose “Bounce to Disk” from the File menu.
3. Set the options as shown and click “Bounce.”
4. Save the file to a location where it can be easily found (the Desktop). This will be the file that is burned to CD.
**Pro Tools — An Easy Path to Creativity for (Almost) FREE**

Dr. Rocky J. Reuter  
rreuter@capital.edu  
Capital University Conservatory of Music — Columbus, OH  
Presented at the ATMI 2004 National Music Technology Conference  
Miami, FL • Friday, October 3, 2003 • Sevilla Room, Hotel Intercontinental

**Background:** *Pro Tools*, by Digidesign, is the industry standard digital audio recording software/hardware and can be found in nearly every professional recording studio in the world. The purpose of this session, however, is to explore its ability to be used as a medium to create digital Musique Concrète compositions. This form of electronic music began in the mid-1950s when Parisian technician/composer Pierre Schaeffer (1910–1995) began experimenting with analog audio manipulation and collage techniques in the radio station studio of the Paris National Radio Station.

**Program Information:** By working in the *Pro Tools* environment, students learn to use a high-end digital audio recording program that can expand with the student’s interest and needs. Although the software can also record MIDI data, it is really designed for working with digital audio. There are a number of software and hardware options and price ranges (note: manufacturer’s recommended prices are given below):

- **Pro Tools Free:** As long as you already have a computer with at least 128k or RAM, this cross-platform (Mac OS9, Windows 98 or ME) option really is free, with no specialized hardware to purchase. *Pro Tools Free* can be downloaded from the Digidesign website (http://www.digidesign.com). This version is extremely functional and looks almost exactly like the full versions of the software, including up to 24-bit recording, audio manipulation tools, real-time effects, and virtual mixer automation. It even uses the internal audio card and mic input of the computer, so the only hardware you need to add is a reasonable microphone and a pair of speakers. *Pro Tools Free* does have some limitations however, including a maximum of 8 tracks of audio and 48 tracks of MIDI, relatively limited audio manipulation plug-ins, and a few tools that work slightly differently than the full-featured versions.

- **Pro Tools LE and Mbox:** Moving up to *Pro Tools LE* requires *Mbox*, a 2-channel 24-bit USB analog audio interface that costs under $500. This I/O unit (In/Out) has two mic preamps to allow for high quality input. Up to 32 audio tracks and 256 MIDI tracks are available, plus a host of additional plug-ins for audio manipulation.

- **Pro Tools LE and Digi 001 / Digi 002:** The *Digi 001* is a single rack mount unit that is more limited track capacity than the *Mbox*, though it has 18 discrete I/Os and cost about $1k. It has been superceded by the FireWire-based *Digi 002*, which costs about $1.3k in its rack version or $2.5k in its scontrol surface version (which can be used as a standalone digital mixer). Either version maintains the 18 discrete I/Os and 32 tracks of audio, but limits MIDI to 128 tracks.
• **Pro Tools Mix, MixPlus, 24 Mix and HD:** The Mix series is a full-featured, flexible professional recording studio level software/hardware system. Recently upgraded to Pro Tools |HD, the newest protocol allows up to 96 I/Os and up to 192 simultaneous audio tracks at up to 192 kHz sample rate. A base system costs about $10k and, with expansion and control surfaces, can mount to well over $25k (not including microphones, outboard gear, studio-quality speakers, and appropriate furniture).

**Pedagogical Comments and Suggestions:** From a pedagogical standpoint, the system that is used is of little concern. Students can learn the software basics equally well using Pro Tools Free as they can using an HD setup. In fact, the look and feel of the software changes very little from one version to another. Ultimately, the choice comes down to the available budget. Because Pro Tools Free is, in fact, free and can be made available legally on all university lab computers and acquired by students for use on their personal computers, it is the logical place to begin.

**Pro Tools Free Lesson Plan 1:** Create and pre-load a sample file that includes one track of pre-recorded sounds that can be used by students to explore the software protocols.

- Inform students how to download Pro Tools Free for their personal use
- Instruct students to double-click on the file icon to open the program
- Guide students through the navigation process
- Explain the primary editing tools (Grabber, Selector, Trimmer)
- Explain “non-destructive” editing & the Audio Region List
- Explain moving and copying waveforms & the placement modes (Slip, Shuffle, Spot, Grid)
- Instruct students to experiment with Audio Suite Non-Destructive Editing Plugins

**Pro Tools Free Lesson Plan 2:** Use the sample file again to expand the student’s knowledge of the Pro Tools Free graphical user interface (GUI).

- Instruct students to open the file using the Open… command in the File menu
- Explain the multi-function data button (waveform, volume, pan, block)
- Explore and manipulate additional data controllers (volume, pan) using the mouse and Pencil Tool
- Explain the Scrubber Tool
- Learn to Hide and Show Tracks
- Experiment with Fades and Crossfades
- Explain and Explore the virtual mixer
- Create a Master Stereo Track
**Pro Tools Free Lesson Plan 3:** Create your own *Pro Tools File*, record your own audio samples, and manipulate the audio to create an original digital *Musique Concrète* project.

- Instruct students to boot up the *Pro Tools Free* program by double-clicking on the program icon
- Create a New Session and name it
- Create a New Audio Track
- Record your own audio clips
- Organize and manipulate your audio clips
- When the project is finished, Bounce to Disk
- Create a CD from the bounced file

**Pro Tools Lesson Plan 4:** If a more advanced *Pro Tools* system is available, have the students begin the project using *Pro Tools Free*, save the file on a removable storage medium, and transfer it to the advanced system for final production.

**Pro Tools Lesson Plan 5:** Create an entire project based on a single sound source that is manipulated in many different and multiple ways.

**Pro Tools Lesson Plan 6:** Combine Audio and MIDI Tracks in a single project.

**Lesson Plan 7:** Explore other programs that can be used to manipulate digital audio.
**Acquiring Pro Tools Free:** To download the program …


2. At the bottom of the Digidesign homepage, click on “Pro Tool FREE”

3. Click on the version you want to download, or order the CD-ROM.

**NOTE:** The Macintosh version of *Pro Tools Free* will not work in OSX or in Classic Mode; you must boot the computer in OS9. Digidesign has not announced whether or not the program will be ported to OSX, but it is likely that it will at some point. Likewise, the Windows version is limited and will not run on XP, NT, or 2000.
ProTools – A Guide to Your First Creative Project:  
From Start to Finish in a Few Hours  
Part I: Learning the Basics Using an Instructor-Prepared File

Using an Instructor-Prepared File: Double-Click on the file icon provided

Navigating in Pro Tools: The following two windows should appear:

Control Window Buttons:
1. Return to 0
2. Incremental Rewind
3. Stop
4. Play
5. Incremental Forward
6. Go to End of Session
7. Record Ready Button  
(Note: all the numbers represent timing/clock cues)

NOTE: If a window is not visible on the screen, you can always choose it in the Windows menu.
Viewing Recorded Audio: The “Audio 1” track is at the top, with graphic representations of the audio files:

The top of the Audio Window represents a timeline, currently set to show minutes:seconds.

- Click the Play Button:
  - Note that the cursor moves left to right across all the tracks
  - Note that the level meter begins to indicate the output volume, which corresponds to the wave’s relative amplitudes
  - Note that the “clocks” are changing with the Main showing Minutes:Seconds:Ticks (the sub is showing SMPTE code)

- Click the Stop Button:

Locate the track’s waveform button: waveform & Click the arrow to change the height of the track.

The Waveform Zoom Buttons allow you to expand and compress the visual waveform:

- Click on the Zoom Tool: then click on the waveform and click/drag/release to expand the waveform. Hold down the option key while doing this to compress the waveform.

Thus far, you have only changed the graphic view of the wave, not the wave itself — it still sounds the same.
Working with the Primary Editing Tools:

• Click the **Grabber Tool**: Then click on a waveform. This selects that audio clip (changes color).
  - Click the Play Button: The clip will play and then playback will stop.
  - Press the Spacebar: This is the same as pressing the Play Button.
  - Press the Spacebar again to Stop playback.
  - Press the `control` key while clicking the Play Button: This puts playback into Loop Mode and the audio clip continues to play until you stop playback (Stop Button or Spacebar). Turn off Loop Playback by control-clicking the Play Button again.

• Click on the **Selector Tool**: Then click and drag on an audio clip. This selects a portion of the wave, allowing you to play only what you want to hear (press the `space bar`). You can re-select as desired.

• Click on the **Trimmer Tool**: Then click and hold on the end of a waveform.
  - The Cursor changes shape to a bracket ( `|` ): Drag the right edge to the left to trim the waveform.
  - Drag the left edge to the right to trim the waveform further.

  Note: You have just made your first Non-Destructive Edit. The entire wave is still there, you just can’t see or hear the “hidden” portions. To reveal and hear them, just use the Trimmer Tool to “open” the waveform back up.

• Click on the Smart Tool Button: This selects all three tools.
  - When you move over a waveform now, the cursor function changes depending on placement:
    - Below Waveform
    - Above Waveform
    - At Beginning or End
      - Grabber
      - Selector
      - Trimmer
Moving and Copying Waveforms:

- Using the Grabber, Click on a Waveform and Drag it Left and/or Right — Note that if you put one waveform on top of another, the “bottom” waveform is automatically trimmed; you’ll only hear the waveform that is on top.
- Using the Grabber, Click on a Waveform and Drag it to Audio Track 2 — Note that it changes color; each track is color-coded.
- Using the Grabber, Click on a Waveform…
  - in Edit menu choose Copy (or command-C)
  - Click later in the track
  - in Edit menu choose Paste (or command-V) — this provides an exact copy of the waveform
- Using the Grabber …
  - press the option key and Drag a waveform — this also provides an exact copy

Here again are the waveforms:

Note that so far, you have been in Slip Mode:

- Slip Mode = you move waveforms anywhere you wish, including on top of another waveform
- Shuffle Mode = snaps one waveform to beginning or end of another; moving one waveform will cause other waveforms to move out of the way (below, the bass waveform has been moved after the cello and abuts footsteps):

- Spot Mode = provides for absolute placement at a specific time point
- Grid Mode = a grid is setup and the waveform is moved in measured grid blocks
**Audio Regions List:** ProTools stores all of its audio clips in the Audio Regions List. You may already see it on the right side of the Edit Window:

If you can’t see this window, click these arrows on the bottom right of the Edit Window. Click them again to hide the window.

If you want to expand/compress the window, click-drag the arrows to the left of “Audio”

The name of each audio sample is found both at the top of the audio block and in the Audio Regions List.

If you click on an Audio Sample and press the delete key, the sample disappears from the track, but remains in the Audio Regions List — another example of non-destructive editing. You can click on the file names in the list at any time and drag a copy of the sample onto an audio track.

**Non-Destructive Sample Editing:** Non-Destructive Editing is possible because ProTools makes a copy of each waveform before it is edited. To demonstrate this, use the Grabber Tool to…

- select the “cello” waveform

- in the Audio Suite menu, select Reverse

  - the Reverse Plugin Window appears:

- clicking the preview button allows you to hear the effect if you press the Spacebar

- clicking the process button makes a “backwards” copy of the waveform and renames the waveform by adding RVRS-00. This new audio clip is added to the Audio Regions List, while the original audio clip remains unchanged.

**Review:** In Part I, you have learned how to…

- use Pro Tools Free’s primary navigation and editing tools
- move, delete, copy, and place audio clips
- edit (manipulate) audio clips in a non-destructive environment
- use the Audio Regions List

In Part II you will experiment with additional elements of the Pro Tools Free graphical user interface (GUI).
Review: In Part I you learned the basic ProTools interface and how to use its basic tools. You will make use of these tools every time you use this program. However, these tools are only the beginning of ProTools’ creative possibilities. In this session we continue to learn additional tools and interface components.

Open the Instructor-Prepared File: This time, use the File menu’s Open… command, find the file, and double-click on the file name.

Naming Tracks and Understanding Track Buttons and:

Some of the Track Buttons:
- Audio 1 = track name; double-click to change name
- rec = record enable button (turns red when track is on)
- solo = when on, all other tracks (w/o solo on) will be muted
- mute = this track will not be heard
- vol = track output volume
- pan = left / right panning

(NOTE: the other buttons will be discussed later)

- Click here to change the vertical size of the track (graphic effect only, does not affect audio)
- Click on and choose volume
- The waveform recedes into the background and a line appears:
- Clicking on the line produces a “handle”
- Clicking and Dragging causes the line to move up (louder) or down (softer)
- New handles can be added anywhere and can be moved to create complex volume controls
The Pencil Tool:

- The Pencil Tool can also be used to modify the volume line.
- Click and hold on the Pencil Tool to bring up several auto-shapes from which to choose:

  \[ \text{Experiment with each of these to hear how each affects the audio track.} \]

- Click on the button and choose pan.
- Another line comes up that represents center-balanced left and right channels.
- This line is modified in all the same ways as the volume line:
  - The top of the track represents hard Left.
  - The bottom of the track represents hard Right.
- Any of the handles can be removed by using the selector tool to highlight them and pressing the delete key.
- The volume and pan readouts indicate the position of the lines during playback.

The Scrubber Tool allows you to click anywhere in the session and scrub the audio by moving the mouse left and/or right. Scrubbing is in real time unless you also hold down the option key, which produces fast scrubbing.

Hiding and Showing Tracks: As your session grows you will probably add several tracks, but you may not always want or need to see all of the tracks. The left side of the Edit Window also has a “hidden” window. To view the Tracks List click on the arrows in the bottom left corner, which shows the Hide/Show tracks window.

All of the highlighted tracks will be visible. Clicking on a track name will toggle it between Show and Hide.
**Fades and Crossfades:** While these effects can be accomplished through judicious use of tracks and volume controls, ProTools has an extensive dialog box for these effects.

Fades: A Fade is defined as either going from silence to sound (fade in) or vice versa (fading out).

- select the portion of any waveform that you want to fade

![waveform](image1.png)  ![partially-selected form](image2.png)

- in the Edit menu select Fades > Create Fades
- the dialog box to the right will appear
- choose the type of fade desired and click OK, which will result in a waveform similar to this

Crossfades: A Crossfade is defined as two overlapping sounds with one fading out and the other fading in.

- begin by rather significantly overlapping the end of one waveform with the beginning of another:

![two normal waveforms](image3.png)  ![same waveforms overlapped](image4.png)

- select the overlapped portions:
• in the Edit menu select Fades > Create Fades

• the window at the right appears:

• select the type of crossfade you desire

• click OK

• if the dialog box below comes up…

• Click Adjust Bounds; the program will process the fade; the result will be something like the one to the right, showing the area of the crossfade:

• if you want to delete any fade, simply click directly on the fade, then in the Edit menu select Fades > Delete Fades or simply press the delete key.
The Mix Window (to the right) provides a “fader” for each track similar to a mixing board, complete with sends and inserts, panning, etc., and all of the data is automated through the software.

In the Windows menu, choose Show Mix

As with the Tracks Window, you can choose to Show or Hide any faders desired.

Recording Channel Volume Data:
- do NOT enable the track to record — not red!
- click on the auto write button and choose “auto write”
- Click Play and move fader with mouse
- stop the playback
- the button changes to auto touch and allows you to change the fader as desired on subsequent playings
- when you are done, change the button back to auto read

Recording Panning Data:
- do NOT enable the track to record — not red!
- click on the auto write button and choose “auto write”
- Click Play and move the pan slider with the mouse

Assigning Plugins: Audio Suite Plugins only effect selected sounds. Channel Plugins effect everything on a particular channel.
- click on an insert position to bring up the plugins:
- choose the desired plugin and set it up as desired.

Creating a Master Stereo Track controls the overall volume of all other tracks. You need this if, in the end, your volume indicators are peaking (turning red).
- in the File menu select New Track…
- click on Audio Track and choose Master Fader (stereo)
- the new track appears and controls the overall volume of the entire mix output.

NEED HELP? In the Help menu, choose ProTools Reference Guide
Review: In Parts I and II you learned how to use the Pro Tools Free GUI. In Part III you will learn how to put that knowledge to work as you organize and manipulate audio clips that you create.

Open Pro Tools Free by double-clicking on the program icon:

Create a New Session by selecting New Session… in the File menu:

— in the File menu, select New Session…

(Note: If you’ve already created a session, choose Open Session… or double click on the file icon.)

When this window appears,

1. This tells you where the file will be saved. Click on it and choose Desktop.

2. Type your name here

3. Click the Save button

The window to the right will appear — set the bit depth to 16 (because you are eventually going to record to CD, which requires 16 bit depth) and click OK

The folder to the right, with your name on it, should now appear on the Desktop

If the windows you have seen before do not appear, simply select Show Edit and/or Show Mix in the Windows menu.
Creating New Audio Tracks:

In the File menu choose New Track… and the following window appears:

---

| Create |  | new | Audio Track |

— Type the number of desired Audio Tracks and click Create

The following track will appear in the Edit Window:

---

Recording Audio:

1. Plug a microphone into the computer’s mic jack (the computer’s sound control panel’s sound in choice must be set to “built in”).

2. Record Enable the first track by clicking (it turns red)

3. Click on the Control Window Record Button (it begins to blink)

4. Click the Play Button to record the desired audio, making sure the level is sufficient

   (the cursor moves left to right, the track turns pink, a waveform appears)

Conclusions: You are now ready to begin organizing and manipulating your audio clips. Take the time to thoroughly experiment with the various plugins in the Audio Suite menu and push them to the extremes. During the creative process, seek out quality recordings by noted composers of electronic music created in this manner. Your creativity will be limited only by your imagination and the limitations of the hardware and software you use. If a more advanced Pro Tools system is available, you are encouraged to explore the expanded capabilities of that system. When your project is finished, use a CD burner to save the audio file for standard playback. Finally, investigate other programs that deal with digital audio manipulation and determine which program best meets your creative needs.
Appendix 4
Supplemental Materials

Digital Audio
Supplemental Fact Sheet 1

1. List some ways to use sounds in a multimedia presentation.
   [Present musical examples, background music, feedback for correct and incorrect responses.]

2. How does one add sound to a multimedia presentation?
   Method 1: Use the presentation program’s audio recording tool to record a new sound, if applicable.
   Method 2: Choose “Insert” or “Import” from the program’s menus and choose an existing sound file.

3. How does one create new sound files?
   Run an audio recording/editing program. Record a sound file using a microphone and save the file as a wav or mov file.

4. What are other issues to consider when recording sound?
   [See the Digital Audio Handout on the next page.]

5. How does one perform copy and paste editing with a sound program?
   [Select the desired portion of the sound file. This is usually accomplished by dragging the mouse over a portion of the sound and listening to see if the selection is correct. Most programs also allow the selection to be made by entering starting and ending times. When the desired portion is selected, choose “Copy” from the Edit menu. Click the mouse at the point in the sound where the copied data should appear and choose “Paste” from the Edit menu.]

6. HOW DOES ONE ADD EFFECTS SUCH AS REVERB OR ECHO TO A SOUND?
   [Select the desired portion of the sound file. Choose the option from one of the menu’s which adds the desired effect. Frequently the effect requires parameters (how slow an echo to add, how many recursions of the echo should be included, what should the relative strength of each recursion be, etc.). Effect options are usually set in a dialog box with sliders and field for entering values. Usually effects may be tested before they are applied or saved. At any rate, it is a good idea to save a copy of the sound file before applying an effect and/or undo the effect immediately if the effect does not work as desired. Some software supports non-destructive editing. This means that any operation can be undone. If necessary the file may be reverted to any recent version or to the original.

   In some programs it is possible to apply effects to a track by adding an “insert.” In these cases, it is possible to experiment with different settings and combinations of effects without changing the underlying data.]

7. How does one save a sound in an appropriate file format.
   [Choose “Save As” from the file menu. Specify a file name, location to be saved, and the desired format in which the file should be save. Click OK. In some programs, it is necessary to do a “mixdown” or “bounce” to create a file to be burned to disk. In some programs, “export” must be used to create a file in an appropriate format.]
MIDI

1. What is a MIDI file and how can it be used in a multimedia presentation.
   MIDI files are the files generated by sequencing or notation programs. They contain instructions for
   playing music on an external device such as a synthesizer or sound card.
   MIDI files are used to add long musical examples to presentations. They are quite compact but they
   do not contain digital recordings of specific sounds.

2. How does one add an existing MIDI file to a multimedia presentation?
   Choose “Insert” or “Import” from the program’s menus and select an existing MIDI file.
   NOTE: Some presentation software may require that a MIDI file be converted to a movie first.
   If so, the following procedures show how to do this using MoviePlayer on an Apple or Windows
   computer.

   [Convert MIDI Files to movies.]
   Run Movie Player Pro
   File --> Import
   Click the “Convert” button
   Click the “Options” button
   Turn on “Add Silence to the Beginning”, “Add Silence to the End”,
   Rename the file to “filename.mov”, navigate to the desired folder, and click “Save”
   Once the movie is imported, the instruments for each track may be set.
     Movie --> Get Info
     Choose the “Music Track” from the popup menu on the left.
     Choose the “Instruments” option from the popup menu on the right.
     Set the instrument for each track.
   File --> Save As
     Select “Make Movie Self Contained”
     Select “Compatible with non-Apple Computers”

3. How does one edit an existing MIDI file?
   Open the MIDI file with a sequencing program. With the sequencing program any number of edits
   may be made. The tempo may be changed, ritards and accelerandos may be added, graduated and
   terraced dynamics may be applied, different instruments may be assigned to each voice, voices may be
   muted or removed from the arrangement, the piece may be transposed, and more.

4. What are the different types of MIDI files?
   Type 0 has all channels saved within a single track within the file.
   Type 1 has all channels saved in different tracks within the file.
   Type 2 has multiple songs saved within the file.
   Type 1 is recommended for most purposes.
   Note: Some older software will only read or write one of these formats.
5. When working with Standard MIDI Files, the following concepts are important. Explain each:

A. Digital Audio-
   MIDI files record the barest essentials of a musical performance - which note was played, when it was played, how loud it was played, how long it was played? Very little additional information is recorded. MIDI files do not typically include digital recordings of specific performers or performances.

B. Playback Device-
   MIDI files surrender many aspects of musical performance to the synthesizer or sound card during playback. The quality of the playback device directly affects the quality of the MIDI file.

C. Arranging Artfully for the Worst Possible Playback Device-
   It is good to consider arranging MIDI files in such a way that they sound good on a wide variety of timbres.

D. General MIDI and Patches-
   General MIDI establishes a common bank of sounds which all modern synthesizers and computers share. When creating MIDI files for the internet write for general MIDI instruments.

E. Other Tips-
   - Either use general MIDI patches or don't include them.
   - Don't quantize so much that the piece sounds "stiff".
   - Don't create MIDI files with notation programs which quantize everything.
Appendix 5
Digital Audio Presentation Outline

Digital Audio Recording Basics
Tom Rudolph

OUTLINE:

Recording Digital Audio
What is the goal?
• Recording student practice sessions and rehearsals
• Recording CDs
• Recording live concerts
• Developing a Recording Studio in the school

Digital Audio Options
• Using the Computer
  • Built-in hardware (for reference only)
  • Digital Signal Processing Device
• Stand-alone Recording Units
  • CD Recorders
  • Multitrack Units

Software (Computer) Options
• 2 Track Digital Audio Software
• Multi-track Digital Audio Software

Low Cost Option
• Advantages – least expensive
• Disadvantages - Sound quality is poor
• Needed
  • Computer
  • Large Hard Drive
  • Digital Audio Software
  • Input device – microphone or other device that will work with your computer.

Mid-level Options
• Advantages
  • Improved quality of sound
  • Multiple Tracks
  • Combine MIDI and Digital Audio
• Disadvantages
  • Requires a robust computer
  • Requires a large hard drive
  • Takes time to learn
• What’s needed?
• Computer
• Large Hard Drive
• Digital Audio Software
• Digital to Analog Converter Box

Burning CDs from Computer
• iTunes – Free from Apple
• EZ CD Creator (Windows)

Stand Alone Devices
• Easy to use - Just plug in a microphone and press record
• Little editing possible on the device but the resulting CD can be taken to a computer and edited there.

Microphones
• Uses Condenser for concert recording (Audio Technica Stereo Condenser Mic)
• High End Microphones
  • Changeable patterns
  • Multi-purpose – larger diaphragm for vocals and soft volumes

Microphone Stands
• Get a good microphone stand.
• Height and location of the microphone make a difference in the quality of the recording